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1. Introdução 

O  OpenShot  Video  Editor  é  um  programa  concebido  para  criar  e  editar  vídeos,  permite  facilmente 

combinar múltiplos  suportes como vídeos, áudio e  imagens num único projeto, e depois exportar em 

muitos formatos de vídeo. 

O OpenShot é um editor de vídeo não‐linear, o que significa que qualquer vídeo, ou parte deste, pode ser 

acedido a qualquer momento, os vídeos podem ser dispostos em camadas, misturados, e arranjados de 

maneiras criativas. Todas as edições sobre os vídeos  (aparar,  cortar, etc...)  são não‐destrutivas, o que 

significa que os vídeos originais nunca são modificados. 
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2. Instalação para sistemas Windows 

2.1. Obter o Openshot 

Para instalar o Openshot deve primeiro descarregar a versão para o seu sistema operativo. Para tal basta 

aceder a http://openshot.org/download/, escolher a versão do seu sistema operativo. 

 

E de seguida clicar na ligação da versão que deseja. 

 

2.2. Instalar o Openshot 

Despois  de  descarregar  o  instalador  do Openshot  navegue  no  seu  sistema  até  ao  local  onde  este  foi 

colocado,  normalmente  na  pasta  das  Transferências,  e  clique  duas  vezes  sobre  o  ficheiro 

OpenShot+Video+Editor‐2.0.6‐win32.msi. 

Autorize a execução do programa na mensagem que é apresentada. 
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De seguida deve indicar a pasta onde quer instalar o Openshot e clicar em Next, ou simplesmente clique 

em Next se quiser utilizar a pasta por defeito para a instalação. 

 

Confirme a  instalação na mensagem que surge de seguida e espere que a  instalação decorra. No final 

basta clicar em Finish para terminar a instalação. 

 

Se surgir a mensagem seguinte deve clicar em Yes para reiniciar o seu computador. 
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2.3. Instalações complementares (não obrigatórias) 

Para  poder  editar  os  títulos  e  genéricos  do Openshot  é  necessário  instalar  mais  duas  aplicações,  o 

Inkscape, para os títulos 2D, e o Blender, para os títulos 3D. 

Obter e instalar o Inkscape 

O programa Inkscape pode ser descarregado do endereço https://inkscape.org/pt/transferencias/. Deve 

escolher o instalador (msi) que se adapta ao seu sistema, 32bit ou 64bit. Se não sabe qual é o seu sistema 

deve optar pela versão 32bit pois funciona nos dois. 

 

Depois  de  descarregar  o  instalador  navegue  no  seu  sistema  até  ao  local  onde  este  foi  colocado, 

normalmente na pasta das Transferências, e clique duas vezes sobre o  ficheiro  inkscape‐0.91‐x64.msi, 

para a versão de 64bit, ou inkscape‐0.91.msi, para a versão 32bit. 

Autorize a execução do programa na mensagem que é apresentada. 
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Clique em Next no quadro seguinte. 

 

Aceite o contrato de licenciamento e clique em Next. 

 

Escolha  a  opção  Complete  para  instalar  o  programa  e  todas  as  suas  funcionalidades.  Se  pretender 

personalizar a instalação deve escolher a opção Custom onde pode escolher os módulos do programa a 

instalar e a pasta de instalação. 
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Na mensagem seguinte deve clicar em Install, deve confirmar a instalação na mensagem que surge de 

seguida e espere que a instalação decorra. 

 

No final basta clicar em Finish para terminar a instalação. 

 

Obter e instalar o Blender 

O  programa  Blender  pode  ser  descarregado  do  endereço  https://www.blender.org/download/.  Deve 

escolher o Installer (.msi) que se adapta ao seu sistema, 32bit ou 64bit, de um dos locais disponibilizados. 

Se não sabe qual é o seu sistema deve optar pela versão 32bit pois funciona nos dois. 
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Depois  de  descarregar  o  instalador  navegue  no  seu  sistema  até  ao  local  onde  este  foi  colocado, 

normalmente  na  pasta  das  Transferências,  e  clique  duas  vezes  sobre  o  ficheiro  blender‐2.76b‐

windows64.msi, para a versão de 64bit, ou blender‐2.76b‐windows32.msi, para a versão 32bit. 

Autorize a execução do programa na mensagem que é apresentada. 

 

Clique em Next no quadro seguinte. 

 

Aceite o contrato de licenciamento e clique em Next. 
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De seguida deve indicar a pasta onde quer instalar o Blender, clicando em Browse… e navegando no seu 

sistema até à pasta de instalação pretendida, e clicar em Next, ou simplesmente clique em Next se quiser 

utilizar a pasta por defeito para a instalação. 

 

Na mensagem seguinte deve clicar em Install, deve confirmar a instalação na mensagem que surge de 

seguida e espere que a instalação decorra. 

 

No final basta clicar em Finish para terminar a instalação. 
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2.4. Executar o Openshot pela primeira vez 

Procure no seu menu “Iniciar” pelo programa OpenShot Video Editor e clique no ícone. 

 

O programa deteta automaticamente o idioma do sistema e escolhe a tradução apropriada, mas nesta 

distribuição o idioma português está mal selecionado. Para corrigi o problema deve fechar o programa e 

navegar até à pasta onde estão as traduções. 

Se  instalou o programa na pasta por defeito será C:\Program Files\OpenShot Video Editor\locale, para 

sistemas 32bit, ou C:\Program Files (x86)\OpenShot Video Editor\locale, para sistemas 64bit. Se encolheu 

outra pasta para a sua instalação deve procurar esta pasta nesse local. Deve então localizar a pasta pt e 

apaga‐la. 
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Seguidamente copie e cole a pasta pt_BR. 

 

 

De seguida renomeie a pasta copiada, pt_BR – Cópia, para pt. 

 

 

Execute novamente o programa e este já está em português, excetuando alguns itens que ainda estão em 

inglês. 
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3. Alterar o tema do programa 

Se preferir um tema mais claro para o ambiente de trabalho do programa deve ir a Edit>Preferences. 

 

Surge então um quadro onde pode escolher o  tema a utilizar,  escolha o  tema Humanity  e  clique  em 

Fechar. 

 

Clique em OK na mensagem seguinte e reinicie o programa. 

 

O programa está agora com o novo tema. 
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3.1. Integração com o Inkscape e Blender 

Para  utilizarmos  os  programas  Inkscape  e Blender  com  o Openshot  temos  de  indicar  o  caminho  dos 

executáveis destes programas nas preferências. Abra as preferências do Openshot em Edit>Preferences. 

 

Nos campos em frente a Comando do Blender (caminho) e Editor de Título Avançado (caminho), vamos 

colocar o caminho para estes programas. 

Sistemas 32bit 

Os  caminhos  apresentados  são  exemplificativos,  podendo  existir  variações,  e  considerando  que  os 

programas foram instalados nas pastas por defeito, caso tenha escolhido outra pasta deve refletir isso no 

caminho. 

Blender 
C:\Programas\Blender Foundation\Blender\blender.exe 

Inkscape 
C:\Programas\Inkscape\inkscape.exe 
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Sistemas 64bit 

Os  caminhos  apresentados  são  exemplificativos,  podendo  existir  variações,  e  considerando  que  os 

programas foram instalados nas pastas por defeito, caso tenha escolhido outra pasta deve refletir isso no 

caminho. 

Blender 64bit 
C:\Programas\Blender Foundation\Blender\blender.exe 

Inkscape 64bit 
C:\Programas\Inkscape\inkscape.exe 

 

Blender 32bit 
C:\Programas (x86)\Blender Foundation\Blender\blender.exe 

Inkscape 32bit 
C:\Programas (x86)\Inkscape\inkscape.exe 

Assim num sistema a 64bit o quadro ficaria. 

 

Clique em Fechar e já pode utilizar os editores de títulos. 
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4. Instalação para sistemas Mac 

4.1. Obter o Openshot 

Para instalar o Openshot deve primeiro descarregar a versão para o seu sistema operativo. Para tal basta 

aceder a http://openshot.org/download/, escolher a versão do seu sistema operativo. 

 

E de seguida clicar na ligação da versão que deseja. 

 

4.2. Instalar o Openshot 

Depois de descarregar o instalador do Openshot ir até ao local onde este foi colocado, normalmente na 

pasta de Descargas, e clique duas vezes sobre o ficheiro OpenShot‐2.0.6.dmg 
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De seguida deve arrastar o OpenShot Video Editor para a pasta Applications 

 

4.3. Executar o Openshot pela primeira vez 

Na pasta Aplicações o Openshot já se encontra disponível. O programa deteta automaticamente o idioma 

do  sistema  e  escolhe  a  tradução  apropriada,  mas  nesta  distribuição  o  idioma  português  está  mal 

selecionado.  Para  corrigir  o  problema  deve  fechar  o  programa  e  navegar  até  à  pasta  onde  estão  as 

traduções. 

Para tal deve ir a Aplicações e com o botão direito do rato selecionar mostrar conteúdo do pacote. 

 

Ir a Contentes>Resources>Locale 
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Deve então localizar a pasta pt e apaga‐la. Seguidamente copie e cole a pasta pt_BR. De seguida renomeie 

a pasta copiada, pt_BR – Cópia, para pt. 

 

Execute o programa e este já está em português, excetuando alguns itens que ainda estão em inglês. 
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5. Aspeto geral do OpenShot 

 

De forma geral o Openshot apresenta quatro grandes áreas: 

 Arquivos do Projeto 

 Propriedades 

 Pré‐visualização do vídeo 

 Timeline e marcador temporal 

Timeline 

 

Nesta área existem os seguintes comandos:   

 Adicionar  (retirar  ou  renomear)  faixa/trilha.  Recomendamos  a  retirada  de  duas  faixas  e  a 
utilização de APENAS 3 faixas 

 Inserção de marcadores 

 Controlo do campo de edição 

 Indicação de tempo 

Arquivos do Projeto 
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Nesta área existem os seguintes comandos: 

 Arquivos  do  Projeto.  Espaço  em  que  se  colocam  os  elementos  audiovisuais,  as  imagens  e  os 
elementos áudio. Podem ser selecionados por género 

 Transições 

 Efeitos 

Área de Pré‐visualização 

 

Permite a visualização dos elementos colocados na timeline. 

Propriedades 
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6. Como criar e editar no Openshot – Modo simplificado 

Nota Importante: 

Os editores não lineares de vídeo permitem uma distinção na timeline entre pistas de vídeo e de áudio. 

Os  diferentes  planos  são  sempre  colocados  na  pista  1  do  vídeo  e  por  consequência  o  áudio  é 

automaticamente  inserido  na  pista  1  do  áudio.  Nesta  pista  são  também  adicionados  os  off  (texto 

sonorizado). A pista 2 do áudio diz respeito ao som ambiente ou elementos sonoros. 

O Openshot não permite esta distinção! O áudio dos diferentes planos é agregado de forma automática 

ao  plano.  Assim,  de  forma  a  apresentar  uma  coerência  metodológica  de  trabalho,  a  Faixa  0  é  para 

utilização exclusiva dos elementos áudio a serem inseridos em pós‐produção (ex: música), e as Faixas 1 e 

2 são para os elementos visuais e respetiva edição. 

6.1. Criar um projeto 

Devemos criar previamente uma pasta com os elementos audiovisuais e sonoros que vão ser utilizados. 

Vamos a Ficheiro>Salvar Projeto, selecionamos a pasta criada anteriormente, no campo Nome de ficheiro 

escrevemos o nome do projeto pretendido e finalmente clicamos em Guardar. 

Na pasta são criados um ficheiro de nome nomedomeuprojeto.osp e uma pasta de nome thumbnail. 

6.2. Importar ficheiros 

O editor Openshot suporta diferentes tipos de ficheiros áudio, audiovisual e imagens. Com o programa 

aberto pode simplesmente arrastar os elementos que pretendem para a área de Arquivos de projeto. 

 

6.3. Arrastar para a timeline 

Selecionar  o  ficheiro  e  arrastar  para  a  timeline.  Do  lado  esquerdo  ficam  as propriedades  do  ficheiro 

selecionado. 
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Notas: 

 Deve utilizar a Faixa 0 para os elementos sonoros a adicionar em pós‐produção, e as Faixa 1 e 2 
para os elementos audiovisuais e/ou visuais. 

 Se as propriedades não estiverem visíveis, clique com o botão direito no ficheiro desejado e clique 
em Proprieties. 

 

6.4. Elementos sonoros 

Selecione o  ficheiro  e  arraste‐o para  a  timeline.  Do  lado  esquerdo  ficam as propriedades  do  ficheiro 

selecionado. 

6.5. Pré‐visualizar o projeto 

Para pré‐visualizar o vídeo basta clicar no botão de Reproduzir. 

6.6. Exportar o vídeo 

Para exportar o produto vamos a File>Exportar Vídeo. 

 

No campo Nome do arquivo escrevemos o nome pretendido para o nosso ficheiro. Em Destino devemos 

selecionar Avi (h.264) e clicar em Exportar Vídeo. 
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7. Questões técnicas 

7.1. Inserir marcadores 

Colocar o marcador  de  tempo no  local pretendido,  inserir o marcador  recorrendo ao  triângulo verde 

invertido. 

 

O marcador depois de inserido assume o aspeto de gota azul conforme a imagem. 

 

7.2. Retirar marcadores 

Para retirar o marcador basta selecionar a marcação e com o botão direito do rato clicar em Remover 

Marcador. 
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7.3. Como cortar os elementos 

Para cortar o plano clique com o botão direito do rato no elemento desejado e seguidamente em Cortar 

Clipe e selecionar a opção pretendida. 

Se optar por manter ambos os lados, o plano é dividido em dois planos. Se optar pelo lado direito, só a parte direita 

do plano permanece. No lado esquerdo sucede o inverso. 

 

7.4. Diminuir o plano 

Outra opção possibilita diminuir o plano na timeline. Basta selecionar o ficheiro que pretende e diminuir 

com o rato. 

7.5. Volume 

 

Selecionar com o botão direito do rato o elemento pretendido e clicar em Volume>Redefinir Volume. 

Aqui existem diferentes opções, como exemplo. 
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7.6. Transições e efeitos 

A utilização de transições e efeitos deve ser q.b., ou seja o recurso a estes elementos deve ser ponderado 

quanto ao seu impacto. 

 

Selecionar  transição  ou efeito  pretendido  arrastar  para  o  elemento  pretendido  e  definir  o  tempo de 

exposição. 

7.7. Outras formas   

Em Proprieties também é possível gerir diferentes elementos, como por exemplo o volume. 
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8. Comandos essenciais 

As seguintes teclas permitem controlar diferentes aspetos da reprodução de vídeo do openshot: 

 J: avançar ou recuar o vídeo 

 K: avançar de forma lenta o vídeo. Útil para posteriores cortes de plano precisos. 

 L: avançar de forma rápida o vídeo. 

 Botões direcionais (esquerda, direita, baixo): controlam também a reprodução de vídeo. Útil para 
posteriores cortes de plano precisos. 

 Barra de espaços: reprodução e pausa do vídeo 
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9. Criar títulos 

Os títulos permitem a inserção de identificações. 

Para inserir um título vá a Título>Título. 

 

Abre uma nova janela Editor de título: 

 Template: onde podemos selecionar o modelo para o título. 

 Font: onde definimos a fonte a utilizar. 

 Text: onde escrevemos o texto para o título. 

 Background: onde definimos a cor para o fundo do título. 

 Avançado: podemos utilizar a edição avançada caso tenhamos feito a integração com o Inkscape. 

 

Exemplo: 

 

No final clicar em Save para gravar o título. Não utilize carateres portuguese, carateres acentuados ou 

cedilhas, no nome do ficheiro do título pois pode ter problemas para o colocar na timeline. 

 

O ficheiro fica disponível nos Arquivos do Projeto. 



Pag. ‐ 28 de 29 

 

Arrastar título para a timeline. 
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10. Notas Finais 

Devemos evitar o recurso a efeitos e/ou transições em demasia. 

11. Breve Glossário 

 Efeitos – elementos audiovisuais de valorização da imagem. 

 Off – elemento sonorizado do texto jornalístico. 

 Plano – elemento audiovisual. 

 Som – elemento sonoro do plano. 

 Transições  –  elementos  audiovisuais  inseridos  nos  planos  de modo  a  permitir  uma  transição 
suave. 

 Timeline – Linha de tempo. 

 Trilhas/Faixas – espaço referente à timeline e onde se processa a edição. 

 Vivo – elemento audiovisual com declarações de um, ou mais, entrevistados. 


